
© Huntron, Inc 2020 Rev. 10 1 

Huntron Workstation (v 4.3) Tutorial 
Installation Instructions 3 

Huntron Workstation Main Interface 4 

The Toolbar 5 

Hardware Setup 5 

Using a ProTrack 7 

Using a Tracker 3200S 8 

Using a Tracker Model 30 9 

Manual Modes – Tracker and Scanner 9 

Creating a Board Test 10 

Converting a Test Created in Workstation 4.2 10 

Huntron Convert MDB Application 11 

Test Building Procedures 12 

Creating a Board Database 13 

Adding a New Sequence 13 

Component Package Types 15 

Adding a New Component 16 

Tree/Pin Tab 17 

Adding a New Range 18 

Mounting a PCB in an Access Prober 23 

Prober Setup – Camera Offset part 1 24 

Prober Setup – Camera Offset part 2 25 

Camera Offset for Access DH/DH2 25 

Camera Alignment for Access DH/DH2 29 

Prober setup – Alignment part 1 29 

Prober setup – Alignment part 2 30 

Creating a Board Image 31 

Prober setup – Component Teach; step 1 (DIP package example) 32 

Prober setup – Component Teach; step 2 (DIP package example) 33 

Prober setup – Component Teach; step 3 (DIP package example) 34 

Prober setup – Component Teach; step 4 (DIP package example) 35 

Prober Setup – Component Teach with Access DH/DH2 35 

Prober Setup – Probe Package Component Teach for Access DH/DH2 39 

Duplicating XY Teach Position for Selected Components 41 

Prober setup – Component Teach Height; step 1 42 

Prober setup – Component Teach Height; step 2 43 



© Huntron, Inc 2020 Rev. 10 2 

Teach Height for Access DH/DH2 44 

Manual Modes – Camera and Prober 46 

Scanning a Sequence or Component 47 

Creating a Scan List 48 

Scan Results 51 

Viewing Signatures – Troublesheet 51 

Viewing Signatures Troublesheet Report 52 

Viewing Signatures – Right Click 54 

View SigAssist Information 55 

Component Scans Information 56 

Component Scans – Right Clicking (Auxiliary menus) 56 

Component Scans – Right Clicking (Auxiliary menus) 57 

Component Scans – Right Clicking (Auxiliary menus) 57 

Range Editing – Right Clicking (Auxiliary menus) 58 

Sequence/Component/Pin Editing – Right Click menus 58 

Component Editing – Component Group Edit 59 

Using Component Group Edit to Offset XY Pin Locations 60 

Pin Editing – Pin Group Edit and Net Edit 61 

Pin Editing 62 

Realign Function 62 

ViewPCB Image 63 

Test Creation - Panelize 64 

Test Creation – Convert step 1 65 

Test Creation – Convert step 2 66 

Test Creation – Convert step 3 67 

Test Creation – Convert Status 68 

Huntron Workstation Buttons Feature 69 

Technical Support 71 

Appendix 1: Using the Set Size Feature for Access Probers 72 

Appendix 2: Huntron Workstation Archive Scans Feature 77 

Appendix 3: Adjusting Camera Settings and Ring Lights on Access DH and DH2 79 

Appendix 4: Manually Placing Component Tags in the Image Pane/Image tab 82 

 

  



© Huntron, Inc 2020 Rev. 10 3 

Huntron Workstation software tutorial 
 
It is very helpful if you have a working knowledge of Microsoft Windows prior to using Huntron 

Workstation.  

 

Installation Instructions 

Install the software BEFORE connecting any hardware. Uninstall any previous versions prior to 

loading the current version. For more installation details follow the “Getting Started” sheet included 

with your Huntron product. 

 

Uninstall any previous versions of Workstation 4.3 prior to installing the new version. 

Insert the Huntron Workstation DVD. The DVD should Autorun and begin the installation process. If 

your PC has Autorun disabled then open a browse window to the DVD and select 

WorkstationSetup.exe. This will begin the installation process. During the install you will be asked 

to install additional software for Access Probers. Select the appropriate response based on your 

Prober hardware (refer to the “Getting Started” documents supplied with the Prober). 

If you purchased CAD Tools then install using the supplied CD. Follow instructions listed in the CAD 

Tools Tutorial. 

If you are using Workstation in conjunction with a digital multimeter, follow the instructions listed 

in the Workstation DMM Tutorial. 

All of the Workstation tutorials are available on the Huntron web site: 

www.huntron.com/sales-support/software.htm 

 

 

http://www.huntron.com/sales-support/software.htm
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Huntron Workstation Main Interface 

When starting Huntron Workstation for the first time, you will be prompted for an activation code. 

Type in the code exactly as it is presented on the installation CD. 

Huntron Workstation 4 has built-in conversion utilities that enable conversion of board tests 

created in 3.X versions of Huntron Workstation. 

 

 

The Main Window for Huntron Workstation 4 features a multi-pane layout so many aspects of the 

test creation and execution can be displayed at the same time. The Panes are interactive to a 

certain degree in that changes in one Pane will affect other Panes. The Panes can be resized, 

floated independently or “tabbed” to the sides of the window. The Status Bar displays information 

about items currently selected and status information while processes are running. 
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The Toolbar 

The Toolbar just under the application menus allows for quick access to several program functions. 

The function of each is broken out in the diagram below. 

 

 

  1. 2. 3. 4. 5. 6. 7.  8.  9. 10.  11. 12. 13. 14. 15. 16. 17. 18. 19.  20. 21. 22. 

 

1. Create New Board database 13. Initialize Prober Home 

2. Open Board database 14. Connect/Disconnect Prober 

3.  Save As… 15. Clear Prober STOP condition 

4. Add New (Sequence, Component or Range) 16. Change Access DH/DH2 Probes 

5. Copy (Sequence, Component, Net or Range) 17. ON/OFF Access DH2 Interior Light 

6. Paste (Sequence, Component, Net or Range) 18. Connect/Disconnect Tracker 

7. Cut (Sequence, Component, Net or Range) 19. Previous Component or Net  

8. Delete (Seq., Comp., Net, Range or Scan) 20. Next Component or Net 

9. Build New (Sequence, Component) 21. Previous Pin 

10. Repeat New (Sequence, Component) 22. Next Pin 

11. Scan Component or Net 

12. Scan Sequence 

 

 

Hardware Setup 
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When first starting Huntron Workstation, select Options from the Tools menu. The Options window 

is used to setup default settings used when working in Huntron Workstation. Select the General 

tab and set the desired Unit of Measure (we suggest using Microns for Huntron Access Probers). 

For this tutorial, the Huntron Tracker 3200S, Tracker Model 30, ProTrack and TrackerPXI will be 

referred to in general as “Trackers”. Specific models will be mentioned by name if certain software 

features apply a specific Tracker model. The ProTrack Scanner, Scanner II and Scanner 31S will be 

referred to as “Scanners”. Specific models will be mentioned by name if certain software features 

apply a specific Scanner model. 

 

 

 

Select the Hardware tab and set the type of Tracker hardware that is connected to the PC, the 

Tracker Port (USB) and Scanner (if connected; Scanner II users should also select the number of 

Scanners connected in the “Scanners” drop menu). Access Probers with Tracker (built-in) 

should select “Access Tracker” in the Tracker menu. 

 

Prober users will need to select the type of Prober, the serial port for the Prober and the Frame 

Grabber type. To determine which COM port the Access USB (for Access USB Probers only) 

connection is using, click the Find button for Workstation to detect the Prober port. If this does not 

work, go to the Windows Control Panel, select System and select Device Manager. Locate the 

Ports settings as shown in the image below. Use the COM number shown next to “HS-20USB”.  

Users with Access DH2, Access with serial number prefix of 532 or 542 and Access 2 with serial 

number prefix of 522 or 552 should select the Prober Serial Port as USB. 
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Check the Enable NI Vision Auto-Align checkbox if you wish to enable the automatic alignment 

process that uses the National Instruments Vision Runtime. This option will function only if the NI 

Vision Runtime has been installed from an earlier Workstation installation (version 4.3.6361 and 

before). Leave this checkbox unchecked to use the newer built-in Auto-Align function. 

Click the Connect buttons to initiate communication with the selected hardware. Once connected, 

click the Save (Permanent) button to save this configuration as the startup default. For initial 

installation using a ProTrack, you will see a message that Loop Compensation was not found. A 

Loop Compensation file will need to be created. 

 

Using a ProTrack 

If a Loop Compensation (Loop Calc) file does not exist for the selected configuration, a message 

will appear asking that Loop Calc be performed with ProTrack Diagnostics. 
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Loop Calc needs to be run before you can use a NEW installation of the Huntron 

Workstation software with a Huntron ProTrack. 

- Select Tools/Maintenance/ProTrack Diagnostics from the menu 

Run a diagnostic routine by clicking the appropriate button in the ProTrack I Diagnostics window. 

Clicking Loop Calc will execute the Hardware Check (except Scanner Test) before running the 

Loop Calc routine. The Loop Calc takes approximately 20 minutes to complete. Once complete, a 

Loop Compensation file is created for the selected hardware configuration. You will also be 

prompted to save a ProTrack configuration or “.PTC” file (the name will be the serial number you 

entered in the Diagnostics window). Click Yes to save the PTC file to your PC. With newer ProTrack 

units (serial number prefix KJ3 or KJ4), you will be prompted by another window displaying 

“Download the LoopCalc settings into the ProTrack for manual control?” Click Yes to download the 

settings. Exit Diagnostics and select Tools/Options/Hardware and reinitialize the hardware by 

clicking the Connect/Disconnect buttons. 

Other functions in the ProTrack Diagnostics allow for reading or writing the ProTrack configuration 

file. The Read from ProTrack button will retrieve calibration and user settings from the ProTrack I 

unit and store them as a text file on the connected computer in the Program 

Files/Huntron/Hardware folder. It is recommended this be performed when setting up the system 

for the first time or after making changes to the ProTrack such as the addition of customs ranges 

and range groups. The file generated should be stored in a safe location. 

The Write to ProTrack button will send the calibration and user information to the ProTrack I unit. 

This can be performed if it suspected that the information stored in the FLASH memory of the 

ProTrack I has been corrupted. 

 

Using a Tracker 3200S 

The Tracker 3200S comes from the Factory calibrated for standalone use. If the Tracker 3200S is 

connected to a Prober or external Scanner cabling, calibration should be performed. 

- Select Tools/Maintenance/Tracker 3200S Diagnostics from the menu. 

Click the Alignment button the Tracker 3200S Diagnostics window. When the Calibrate procedure 

finishes (about 10 minutes), run Verify Alignment. This also takes about 10 minutes to complete. 

The Calibration information is stored in the Tracker 3200S and will be used by the software. If 

changes are made to the cabling or attached instruments, simply run Calibrate and Verify 

Calibration again. 
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Using a Tracker Model 30 

The Tracker Model 30 comes from the Factory calibrated for standalone use. If the Tracker Model 

30 is connected to a Prober, Scanner or other cabling, calibration must be performed. Access 

Probers with Tracker inside come from the factory with the calibration already completed. 

- Select Tools/Maintenance/Tracker Model 30 Diagnostics from the menu. 

Click the Alignment button the Tracker Model 30 Diagnostics window. When the Calibrate 

procedure finishes (about 10 minutes), run Verify Alignment. This also takes about 10 minutes to 

complete. The Calibration information is stored in the Tracker Model 30 and will be used by the 

software. If changes are made to the cabling or attached instruments, simply run Calibrate and 

Verify Calibration again. 

 

Manual Modes – Tracker and Scanner 

     

You may find it useful to manually test some of your components while adjusting the range 

parameters. The two manual modes, Tracker and Scanner located in the Signatures pane, can 

work together to display the signature of a component pin. 

Tracker mode sets the range parameters, channel and tolerance. You can also set the Pulse 

Generator settings (Tracker 3200S and ProTrack only) and use ALT mode to run channel A versus 

channel B comparisons. Signatures will be displayed to the right while probing with hand-held 

probes (select the Real-time check box). The Hold button will capture and hold the current 

signature allowing for quick comparisons. 

Scanner mode allows you to use a Huntron Scanner to interface to the component pins. You can 

set the package type, number of pins and common pins. The Scan button starts a hands free scan 

of the component or you manually increment the pins with the << and >> buttons. The Hold 

button will capture and hold the current signature allowing for quick comparisons. To store 

signatures, you will need to create a Board test. NOTE: Users with Access Probers with Tracker 

inside should select Channel B when using Manual mode. 

  

  



© Huntron, Inc 2020 Rev. 10 10 

Creating a Board Test 

There are a number of steps necessary to creating a board test.  

 

Workstation Tree Structure 

- Board (created Huntron Workstation (.hwdb) database file) 

- Sequence (Test set of Components) 

- Component or Net (name) 

o Pins (name, channel) 

o Ranges (V, F, R range settings) 

 

Example of Board Test Information: 

Board Name: Main Board (creates “main board.hwdb” file) 

 Revision: Rev. A (This field is optional) 

Sequence: IC’s  

Component: U27 (component name) or A2 (NET name) 

Pins: per pin settings for Scan Pin setting, channel, net name, etc… 

Ranges: Per pin settings for common reference pin, tolerance, etc… 

The user has total discretion as to the information input into these fields. There is no “right” way as 

to what information is entered as every user’s situation will be different. The above example is just 

one way the information might be entered. 

Entering information into the Entry windows is very straight forward. The easiest way to move from 

field to field is by pressing the TAB key. You can also use the mouse to click into a particular field 

so you can enter information. 

 

Converting a Test Created in Workstation 4.2 

Workstation 4.3 uses a different database type than version 4.2. To update a version 4.2 test to 

work in version 4.3, select Open from the File menu. In the Open window, select .MDB from the 

file type drop menu. Select the .MDB test file name and click the Open button.  

Note: Select .HBK if you are converting Workstation version 3.X backup files. 
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Click the Convert button to create the new test for version 4.3. The conversion can take some 

time based on the original test size. 

 

 

 

Click the Close button when the conversion is complete. The updated test will be opened in the 

Workstation interface. 

 

Huntron Convert MDB Application 

As an alternative, the conversion process can be run externally by browsing to the Program Files 

(or Program Files (x86))\Huntron Workstation 4.3 folder and double-clicking the 

HuntronConvertMDB.exe application. This application allows you to select an .MDB file created in 

version 4.2 and convert it to the 4.3 database format. 
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Use the MDB Database field to select the version 4.2 test database you want to convert. 

Use the HWDB database field to select the path and name for the new 4.3 database. 

Use the Template HWDB Data field to select the preinstalled Template database. Use the same 

information as displayed in the image above. 

Use the Log File field to select the path and name for the application log file. 

Leave the Gold Disk Number field blank unless you are converting tests used in the US Navy 

Gold Disk program. 

Click the Convert button to start the conversion. You will see a pop-up dialog when the conversion 

is complete. 

 

Test Building Procedures 

- Create Test Database in the Tree Pane 

o Add Board, Sequence, and Components before teaching or scanning 

- Scan Components and Set References (Tracker only or Tracker/Scanner users) 

- Perform Camera Offset (Tracker/Probers users) 

- Select Alignment points (Tracker/Prober users) 

- Teach component pin locations (Tracker/Prober users – teaching all points before scanning 

will save you time) 

- Scan Sequences and Set References 

 

Listed above is a general outline on how you would proceed when preparing to test a board. These 

guidelines apply to all package types and boards. As with any type of complex test equipment, 

practice makes perfect so take the time to learn and practice these procedures. 
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Creating a Board Database 

 

 

 

To create a new Board, select New from the File menu or use the New button in the toolbar. Input 

information into the “Add New Board” dialog as needed. The only field that is required is board 

Name. Other fields such as Revision, System, Unit, Manufacturer and Gold Disk Number can be 

completed with related information if desired.  

Access Prober users should select their desired Units of Measure. This controls which units (mils, 

inches, microns, or millimeters) are used in the Prober movement controls.   

 

Adding a New Sequence 
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To add a new Sequence, select the Sequence tab in the Tree pane. Select Add New Sequence 

from the Edit menu or click the Add New button (+) in the toolbar. 

Details: 

Sequence Name Field: Enter Sequence name 

Slot field (Prober users): Select the Prober slot that the board will be mounted into when scanning. 

Select from TOP, MIDDLE, BOTTOM or BASE (Access 2, Access DH). 

Compare Priority: Selects the comparison priority between Same (serial number), All (serial 

numbers; this is the recommended setting) or Merge (Merged min/max signatures) 

Instructions field: Enter any instructions or system information that you wish to pass on to 

future users.  

The Delete Scans button will erase all scans stored under the Sequence. 

NOTE: Access DH/DH2 users should select the Testers tab and check the “Enable Access DH, 

DH2” checkbox. 

Buttons… button adds a new user configured Toolbar button. See the Buttons section at the end 

of this tutorial. 

NOTE: You can set your Sequence defaults using the Tools menu/Options/Sequence tab. 

Access DH users should make sure the “Enable Access DH” checkbox is checked.  

 

Other functions within this window can be read about by clicking the HELP button. 
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Component Package Types 

 

There are four different package types you will find yourself using when creating components used 

in a Prober test sequence. The XY locations for each package type are “taught” in slightly different 

ways. They are DIP (dual-in-line), SIP (single-in-line), PROBE (point by point), and MULTI 

(multiple row or sided).  

 

For Tracker with Scanner users, the package type determines how the Scanner pins are counted. 

The available Scanner packages are DIP, SIP, Both, Front, SIP2X (combines the A and B 

channels for 128 pins) and DIP2X (combines the A and B channels for 128 pins). Users of the 

Scanner II accessory have a DIPII and SIPII package available allowing them to daisy-chain 

Scanners together to achieve up to 1024 pins. 

Users of Probers and Scanners have a MULTI-SIP package that lets them to probe a component 

as MULTI package while the Scanner counts through the front connector as a SIP package. This 

allows for selection of Common references through the Scanner to the Prober mounted board-

under-test using a custom cable. 

 

Prober users will use the DIP, 

SIP, MULTI and PROBE 

packages. 

Tracker with Scanner users 

will use DIP (including DIP2X), 

SIP (including SIP2X), FRONT, 

BOTH, DIPII or SIPII 
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Adding a New Component 

 

To add a new Component, select the Component tab in the Tree pane. Select Add New 

Component from the Edit menu or click Add New button (+) in the toolbar. 

Details: 

Component Name field: Enter the component name (reference designator) in this field.  

Package and Number of Pins fields: Using the mouse, click on the down arrow to the right of the 

field to bring up the pull-down menu. Select the package type and number of pins from these 

menus. For Access DH/DH2 users it is recommended that you select Number Of Pins as 1 for 2 

pin Probe package components such as resistors and capacitors. 

Type field: This information is optional but you can enter the component type in this field.  

Pin Spacing: For prober users, you can enter the spacing between component pins in this field 

(i.e. mils, microns, mm or inches depending on Board level setting). This will be used to calculate 

distances between key pins when in Teach mode. 

Connection Type: Select the type of hardware used to interface to the component 

Open Check Type: Select from None, Recheck or Reprobe to retest test points that are detected 

as open. Selecting Recheck will test the point with the probe lowered the distance set by Open 

Recheck Depth. Reprobe will raise and lower the probe several times then retest. The number of 

“reprobes” is set in the Tools/Options/Prober tab. 

Correction Steps: Sets the maximum amount of correction steps used with the Huntron Access 

Prober when moving to the first pin of the component. 

Instructions field: Enter any instructions or component information that you wish to pass on to 

future users. Version 4.3 allows you to paste rich text format (RTF) information into the 
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Instructions field. This includes formatted text and images. Since RTF data is required in the 

Instructions field you will need to first paste an image into Word or WordPad then copy it from that 

application and paste into the Instructions field. 

Other functions within this window can be read about by clicking the HELP button. 

 

Tree/Pin Tab 

Once a component is added to the Workstation Tree, switching to the Pin tab will display 

information for each pin of the selected component. 

 

Text in the Name field can be modified directly by clicking in the text field and typing the new 

name. The Scan Pin setting enables or disables scanning of the pin. Pause will cause the scan to 

pause when the selected pin is reached. The Channel field controls which channel (A or B) is 

used. Controls for the Pulse Generator (ProTrack and Tracker 3200S) can also be controlled at the 

Pin level. These control include Pulse Type (polarity), Pulse (on/off), Pulse Level (amplitude) 

and Duty Cycle (up to 50% on pulsed signals).  

Information on the other settings in the Pin tab is available in the Workstation Help. 
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Adding a New Range 

When a new component is added to a Sequence the ranges used are set by the defaults set up in 

the Tools/Options/Ranges tab. It is best to set up your desired default ranges before adding 

Components to your Sequence. 

  

In the Range/General tab, enable the number ranges and set the tester type as Tracker (default). 

In the Ranges tab, set the Voltage, Resistance and Frequency range parameters. These are the 

ranges that will be used when adding a new Component. It does not change existing Components. 

On a new software installation these defaults set three ranges – 3V, 50Kohms at 500Hz; 3V, 

1Kohms at 200Hz and 3V, 50 ohms at 60Hz. In general use, these three ranges will work well 

but you may need to add or modify ranges based on component type and value. As a general 

reference, the table below can be used to assist you in setting ranges. 
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The Tracker signatures are shaped based on the Tracker range settings and the component 

type/value. The basic goal is to achieve signatures that are halfway between open and short. The 

signatures for the four basic types of components shown below illustrate this primary goal. 

 

 

 

 

 

 

 

 

 

 

 

 

 

To add a new Range to the selected Component, select the Range tab in the Tree pane. Select Add 

New Range from the Edit menu or click the Add New button (+) in the toolbar. A pop-up dialog 

Select the Tree/Range tab to display 
the ranges for the selected 

component pin. RIGHT click on the 

row header (far left grey area of the 
row) to display a quick menu (shown 
left) 

Resistance 

Capacitance 

Inductance 

Semi-conductance 
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will ask where you want the new range to be added. Select the desired radio button (All Pins is 

generally the desired selection) and click OK. 

 

Add New Range Details: 

Note: Voltage/Resistance/Frequency can be modified directly in the Range grid.  

Voltage/Resistance/Frequency fields: Select the desired range settings 

Max Samples/Tolerance/Delay: Select the setting to be used when scanning this range 

Common Pin: Select Scanner common pins to be used when scanning this range. Scanner users 

wishing to use a particular component pin (i.e. ground pin) for Common should select the Common 

pin at this time using the Common Pin 1 field. 

Prober Common Pin: This allow Probers to select a Common connection (1-4) located on the 

front panel of the Prober. 

Note: It is easier to set up the ranges used by selecting Tools/Options/Range from the Tools 

menu in the menu bar and pre-configuring the default ranges. 
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Scanning with a Tracker or Tracker with Scanner 

Users of Trackers with hand probes or Scanners can now proceed with actual scanning of a 

Sequence or Component. To scan an entire Sequence, select the Sequence in the Tree/Sequence 

tab or enable the Sequence checkbox in the Scan tab. To scan an individual component, select 

the component in the Tree/Component tab. Select the Scan tab in the Signatures pane and input a 

Serial Number then click the Start button.  

 

 

 

You will be prompted to connect to the component. Tracker with Scanner users should connect to 

the selected component at this time.  Click OK to initiate the Scan. 
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If you are performing Sequence scan you will be prompted to continue to the next component until 

all of the components in the Sequence have been scanned. 

If a Tracker with probes is being used your will prompted to connect to pin 1 of the selected 

component (if performing a single component scan) or of the first component in the Sequence (if 

performing a Sequence scan). Click the OK button to scan the first pin. You will then be prompted 

to move to the next pin for scanning. Click OK to scan and continue in this manner until all of the 

component pins are scanned. At anytime during scanning you can click the Previous Pin button to 

go back and rescan the previous pin.  

 

 

Once all pins are scanned click the OK button to continue. 

When the Sequence or Component scan is complete the Scan Results window will be displayed. Go 

to the Scan Results section of this tutorial for more information on what to do after scanning. 

If the Tracker Scanner connections are being used (i.e. DIP clip and cable) you will be prompted to 

Connect to the Component before the scan is executed. Connect the Scanner cable to the 

component to test and click OK to start the scan. Once the scan is complete, the Scan results will 

be displayed. 

If you wish to have the Component names appear as tags in the Image pane while you are 

scanning, you will need to enable “Show Components on Image” in the Tools 

menu/Options/Scan tab. Then, follow the instructions listed in Appendix 4 at the end of this 

tutorial to load an image and add Component tags. 
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Mounting a PCB in an Access Prober 

Before software functions relating to an Access Prober can be performed, the PCB under test must 

be mounted into the Prober test area. Use the mounting accessories supplied with the Prober to 

securely mount your PCB by its edges. 

 

 

 

Refer to the Access Prober User’s manual for more information on mounting a PCB. In some cases, 

a PCB holder is the best solution especially when the PCB cannot be easily mounted using the 

standard accessories. PCB holders are typically simple to construct and the only prerequisites are 

that the holder fit into the Prober and that it holds the PCB precisely at one of the designated 

Prober “Slots”. The Slots are referred to by the position in the Prober as TOP, MIDDLE, BOTTOM 

and BASE (Access 2 and Access DH only) and are set in the Sequence Edit window (see section 

“Adding a New Sequence”). 
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Prober Setup – Camera Offset part 1 

 

(Access DH/DH2 users skip to Camera Offset for Access DH/DH2)  

 

 

 

Performing the Camera Offset procedure is essential for the Prober to access test points accurately.  

Select the Offset tab in the Prober pane. Make sure the Mode is set for Camera. 

Use the arrow buttons to move the camera the distance set in the travel distance field (directly 

below the arrow buttons; Note: 1000mils = 1 inch). Navigate the Camera to a target on the PCB 

that is at least 2 inches from the Prober walls. A very small target that is still visible by eye works 

best. You can also click directly in the camera image to move the camera crosshairs to the clicked 

location. Note: If you notice that the camera crosshairs do not move to your clicked location, see 

Appendix 1 at the end of this tutorial. 

This is also the best time to focus your camera. Click the Live Camera checkbox to put the camera 

into Live mode. The aperture ring is the upper ring on the camera lens and the focus uses the 

lower ring. Set the camera to the lowest f-stop of 1.4 and adjust the focus as precisely as possible. 

You can change the f-stop to a higher number after focusing to achieve better depth of field. 

Uncheck the Live Camera mode when focusing is complete. 

When the target is selected, press Set. 

Select Prober in the Mode drop menu to move to the next step. 
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Prober Setup – Camera Offset part 2 

 

 

Caution: It is possible for the probe to contact tall obstacles on the PCB when being moved. 

Visually monitor the vertical probe position as it is moved to avoid probe damage. 

Lower the probe tip down using the Z buttons until the probe just makes contact with the PCB. 

Visually examine the position of the probe tip; it should be located on the target selected in part 1 

of Camera Offset, if not move on to the next step. Use a magnifying glass if necessary. 

Use the XY buttons to navigate the probe to the target selected in Part 1. The probe will lift when 

moving in the X or Y direction. Access USB Prober users may find the Probe Tip Camera (if 

installed) useful in setting the probe tip on the offset target. Select the Live Camera tab in the 

Image pane then click the Select button to display the video source dialog. Select the correct video 

source and click the Start button. A live image will appear in the Live Camera tab. Use the Live 

Camera only when needed as it can draw on computer resources and slow other software 

processes. Use the Stop button in the Video Source dialog to stop the video feed. 

When the probe is placed precisely on the target so it is just touching, press the Set and Save 

buttons to calculate the Offset values. 

 

Camera Offset for Access DH/DH2 

Because the Access DH/DH2 has two Z heads, setting the Camera Offset for each head is 

necessary. The procedure is very similar to the single head Prober process. 

Set the Z1 Probe head first. Select the Z1 radio button in the Offset tab of the Prober pane. Select 

Camera in the Mode field. 
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This is a good time to focus the camera if necessary. For Access DH, enable the Live Camera 

checkbox when focusing. The aperture ring is the upper ring on the camera lens and the focus uses 

the lower ring. Set the camera to the lowest f-stop of 1.4 and adjust the focus as precisely as 

possible. You can change the f-stop to a higher number after focusing to achieve better depth of 

field. For Access DH2, use the AF button to auto-focus the camera. 

Position the camera crosshairs on the center of your chosen target. Note: If you notice that the 

camera crosshairs do not move to your clicked location, see Appendix 1 at the end of this tutorial. 

 

Press Set. Select Prober in the Mode field. The camera image will be disabled. 
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The Probe head will shift to position the probe tip over the target. Use the Z travel buttons to lower 

the probe down to the board surface. Visually examine the position of the probe tip; it should be 

located on the target selected earlier with the Camera, if not move on to the next step. Use a 

magnifying glass if necessary. 

 

 

 

Use the XY buttons to navigate the probe to the target selected earlier. The probe will lift when 

moving in the X or Y direction. When the probe is placed precisely on the target so it is just 

touching, press the Set. 

Now the Z2 Prober head needs to be set. The procedure is the same as the Z1 head. Focus the 

camera if needed. Select the Z2 radio button. Move the Z2 camera to the same point used with 

the Z1 camera. Use the Z1 Image button to see precisely where the Z2 position should be set. 
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Line up on your camera target and press Set. Select Prober from the Mode menu. 

 

Lower the probe down to the board surface. Adjust the XY position if necessary using the XY travel 

buttons.  

 

 

When the probe is placed properly click Set followed by Save to store the Offset values. 

  



© Huntron, Inc 2020 Rev. 10 29 

Camera Alignment for Access DH/DH2 

The Access DH/DH2 allows for an optional Z Head Align step in the Alignment process to achieve 

better accuracy. If the Align Z Heads checkbox is enabled in the Tools/Options/Prober tab you 

will need to perform this process where each camera is placed over a target on the board under 

test.  

Select the Align tab. Select Z1 Camera from the alignment drop menu, move the Z1 camera over 

your selected target and click Set. Select Z2 Camera and move the Z2 camera to the same target. 

Match the position as closely as possible (the Stored Image button shows the Z1 position) and 

click Set. Once complete, perform the Alignment 1 and Alignment 2 as described below for Access 

Probers. 

 

 

 

Prober setup – Alignment part 1 
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Alignment points that are positioned in opposite corners of the board work best. If the test was 

created using CAD data, the alignment points are pre-selected and you should proceed to the 

Teach Height page. 

Select the Align tab in the Prober pane. 

For best accuracy when positioning the camera on alignment points, click the Image Display 

100% button. This will display the camera image at full size with the best pixel resolution. 

Select Alignment 1 from the drop menu. 

Select and navigate the camera to the first alignment point. PCB fiducial marks, small vias or 

traces with 90 degree bends work well for alignment points. 

When the camera is set on the first alignment point press Set. 

The alignment point drop menu will select Alignment 2 automatically. 

 

Prober setup – Alignment part 2 

 

 

Make sure Alignment 2 is selected in the Alignment point drop field. 

Select and navigate the camera to the second alignment point. 

When the camera is set on the second alignment, press the Set button. Press the Save button to 

store the alignment points and the alignment point images. 

Auto Align Feature 

The Auto Align feature will use image recognition to find and automatically center on the 

alignment point. Auto Align will only work after Align is performed manually the first time. Click the 

Auto Align button to start the alignment process. Auto Align may fail to find the alignment points 

if the lighting, PCB color or camera focus is different than when the original alignment was 

performed. If this occurs, simply perform the Align manually as described above. 
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Creating a Board Image 

 

 

For Prober users, the built-in color camera can be used to create a “mosaic” of the PCB by 

capturing images of the board and stitching them together. This is accomplished in the 

Image/Image Pane. The board must first be aligned before creating the image. Once aligned, 

you can use any camera view in the Prober pane to set the borders for image capture. We suggest 

using the Prober/Camera pane rather than the Prober/Align pane or Prober/Teach pane. 

Move the camera to the back right corner of the board. 

Press the Set Back Right button in the Image/Image Pane. 

Move the camera to the front left corner of the board. 

Press the Set Front Left button in the Image/Image Pane. 

The Create Image button should now be enabled, press to create the board image. 

Larger boards will require more time to create the board image. Once the board image is created, 

you can click a point on the board image and the Prober will move the camera to that point. This is 

especially useful in Teach mode to aide in navigating the camera to component positions. 

Right-click on the image to display a menu to Delete, Copy or Save As the board image. The 

Component Display buttons control how component/nets labels overlay on the image. If you 

notice that the image stitching is not precise (overlapped or underlapped images), see Appendix 1 

at the end of this tutorial. Also, you can enable Update Image Pane Cursor (Tools 

menu/Options/Prober tab) to show the current camera position on the Board image. The 

position is shown as a transparent grey box with red crosshairs. 
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Prober setup – Component Teach; step 1 (DIP package example) 

 

(Access DH/DH2 Users go to “Component Teach with Access DH/DH2”) 

 

 

 

Use care when teaching component pin locations. This will ensure accurate probing. This example 

uses a DIP style package to explain the Teach process. Other package types are executed in a very 

similar fashion.  

Select the Teach tab in the Prober pane. 

Select the component to teach on the Tree/Component pane. 

Select pin 1 in the Pin drop menu. 

Navigate the camera to the first pin of the selected component (see image above). 

When the camera is set on the first pin, press the Save button. 

You have two XY Travel default fields available underneath the XY travel arrow buttons. It can be 

useful to set one with a larger travel distance such as 2000 mils and one at a very small distance 

such as 1 mil.  
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Prober setup – Component Teach; step 2 (DIP package example)  

 

 

Navigate the camera to the last pin of the first row (see image above). 

Set the number of pins in the row in the Pins in Group drop menu (for a DIP package, the number 

will automatically be set to half the number of pins). 

When the camera is set on the last pin, press the Save button by the Pins in Group drop menu. 

This sets and calculates the positions of the remaining pins of the first row. 
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Prober setup – Component Teach; step 3 (DIP package example) 

 

 

The pin number will automatically increment from the previous step (see above in the Pin drop 

menu). 

Navigate the camera to the first pin of the next row (see image above). 

When the camera is set on the first pin of the next row, press the Save button. 
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Prober setup – Component Teach; step 4 (DIP package example)  

 

 

Navigate the camera to the last pin of the row (see image above). 

Set the number of pins in the row in the Pins in Group drop menu (it will still show the amount 

selected from step 2). 

When the camera is set on the last pin, press the Save button by the Group drop menu. This sets 

and calculates the positions of the remaining pins of this row. 

 

Teach is complete. Make sure to set the Teach Height before scanning the component. Use the 

Comp> button to increment the Tree to the next component. This will allow you to Teach the next 

component without have to click in the Tree pane. 

 

Prober Setup – Component Teach with Access DH/DH2 

Since the Access DH/DH2 has two probes, the position where each head will be located during 

scanning needs to be taught. The process is very similar to a single head Prober. The Z2 probe 

(typically the Common connected probe) is positioned first followed by the Z1 (Signal connected 

probe) position. In many cases the Z2 probe is positioned to a single point such as ground and held 

there while the component pins are scanned by the Z1 probe. The Z1 camera is used for all 

component location teaching. 

 

 

Select the Teach tab in the Prober pane. Select pin 1 in the Pin dropdown menu. 
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The Z2 and Common buttons should already be selected. Position the camera over the position 

you want the Z2 probe to probe when pin 1 is probed. It may best to find a point to the left of the 

Z1 head that will not interfere with the position of the Z1 probe. The image above shown a point on 

the ground trace being used. Click Save to set this position. To keep the Z2 probe at this position 

while the Z1 probe is scanning, select the highest number in the Pins In Group menu (14 for a 14 

pin component). 

 

 

 

Click the Save button for Pins In Group. If you wish to have the Z2 probe change position for each 

pin scanned by the Z1 head, you will need to teach each pin position individually by selecting the 

pin number in the Pin menu, moving the camera to the desired position and clicking Save. 

Teaching the position of the Z2 probe can take advantage of the Pins In Group function if you 
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wish to speed the process of teaching a row of pins. When the Z2 Teach process is complete, select 

the Z1 Button. 

 

Follow the same procedure used for a single head prober from this point. Select pin 1 from the Pin 

dropdown menu, position the camera over the pin and click Save. 

Move to the end of the row of pins, select the number of pins in the row in the Pins In Group 

dropdown menu. 

 

Click Save to set the group and move to the beginning of the next row of pins. The Pins drop menu 

will automatically change to the pin number for the beginning of the next group (pin 8 in this 

example). 
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Click the Save button to set the beginning of the next row of pins. Move the camera to the last pin 

of the row. 

 

Select the number of pins in the row in the Pins In Group menu (it may already be correct) and 

click Save to set the last row of pins. Use the Comp> button to select the next component in the 

Tree. 
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Prober Setup – Probe Package Component Teach for Access DH/DH2 

Components that are set to Probe package require that each pin of the component be taught 

individually. On the Access DH/DH2 both probes are typically used to probe directly across 

components such as resistors and capacitors. In these cases the number of pins for the device 

would be 1 since the Z1 and Z2 probes each have their own pin 1 position. Start by creating a 

component with 1 pin and the Package set to Probe. 

 

 

 

In the Prober pane/Teach tab select Pin 1 from the drop menu. 
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Move the Z1 camera over the pin you wish to be used for Z2 (usually Common). Make sure the 

Probe and Connect radio buttons are set to Z2 and Common respectively. Click the Save button 

to set the position for Z2. 

 

 

 

Note that the Probe and Connect radio buttons have changed to Z1 and Signal. 

Move the Z1 camera over the opposite pin and click the Save button. 

 

 

The Teach of this component is now complete. 
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Duplicating XY Teach Position for Selected Components 

This feature is for users of the Access DH/DH2 Prober. It allows you to duplicate the position of the 

Z1 or Z2 probe from one component to selected components. This is particularly useful for placing 

a common probe in one location for many components. 

Setting the Z2 probe position will be used in this example but the same steps apply to using Z1. 

Keep in mind that teaching the Z1 position takes place after teaching Z2. 

Start by positioning the Z2 probe at your Common position for the component in Teach mode. Save 

the position for pin 1 then save for all of the pins of the Component using the Pins in Group Save 

button. Right-click the row header for the selected Component and select Group Edit. 

 

You will now see the Component Group Edit window. Select the All Pins tab and select the Z2 XY 

Position button. Note that it is labeled “Before Teach” meaning that this position is taught before 

Z1 to avoid invalid XY positions. 

 

Select the Components in the list (you can use Shift or CTRL keys to select groups or individual 

components) that you want to receive the duplicate Z2 coordinates. When you click Process, the 

selected Components will have their Z2 XY positions set to the same Z2 XY coordinates as the 

selected Component. 

The process is the same for duplicating Z1 positions except that you must teach the Z1 positions 

AFTER setting the positions for Z2.  
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Prober setup – Component Teach Height; step 1  

 

(Access DH/DH2 users go to “Teach Height for Access DH/DH2”) 

 

 

 

Select the Teach Height tab in the Prober Pane. 

Select a Pin number in the Pin drop menu. This will position the probe tip over the selected 

component pin. 

Use the Z Move buttons to lower the Z axis probe to the desired Sequence Up level. Make sure this 

level is high enough to clear tall components. This is the position the probe will lift to while probing 

a component. Click the Save button in the Sequence Z Up section of the window. 

**Important note: If the “Z Home Between Component” setting in the Tree Pane/Sequence 

tab is disabled, make sure the Sequence Z Up position is high enough to clear any obstacle in the 

Prober area.** 

If desired, you can set an additional Up level for the component. This is the level that the probe will 

lift to when moving from one pin to the next. Use the Z Move buttons to move the probe down to 

the desired Component Up level. Make sure this level is high enough to clear the component 

package. Press the Save button in the Component Z Up section to set the Component Z Up 

position.  
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Prober setup – Component Teach Height; step 2 

 

 

The next step is to set the probe down position. Access USB Prober users may find it useful to use 

the Probe Tip camera in setting the probe down position. Select the Live Camera tab in the Image 

pane then click the Setup button to select a video source. Select the correct video source and click 

the Start button. A live image will appear in the Live Camera tab. Do not forget to Stop the Live 

Camera when it is not needed. 

Use the Z Move buttons to lower the probe tip to make contact with the component pin or pad. 

You may want to lower the probe in small increments once contact is made to slightly compress the 

spring probe and ensure good contact. Do this by changing the Z Travel distance setting. The 

signature of the contact point is displayed on the Preview Tab of the Signature pane. Connect a 

common lead to the PCB if you see an open signature. 

Press the Save button in the Sequence Z Down section to set the Sequence Down level. This is 

the level the Prober will use when probing the component pins. 

If needed, you can also set Component Z Down and Pin Z Down levels for individual 

components and pins using. In general use, this is not necessary as the Down level is set at the 

Sequence level.  

To save on PC resources, Stop the Live Camera when it is not needed. 
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Teach Height for Access DH/DH2 

The process of teaching the Z axis position on an Access DH/DH2 is very similar to that of a single 

head Access Prober. 

Select the Teach Height tab in the Prober pane. 

 

Select the BOTH radio button. Select a pin in the Pin menu. The Probe heads will move to put their 

probe tips over the selected pin positions. Use the Z Move buttons to lower the Z1 and Z2 probes 

to the desired Sequence Up level. Make sure this level is high enough to clear tall components. This 

is the position the probe will lift to while probing a component. Click the Save button in the 

Sequence Z Up section of the window. This will set the Up position for both Z axis heads. 

**Important note: If the “Z Home Between Component” setting in the Tree Pane/Sequence 

tab is disabled, make sure the Sequence Z Up position is high enough to clear any obstacle in the 

Prober area.** 

If desired, you can set an additional Up level for the component. This is the level that the probe will 

lift to when moving from one pin to the next. Use the Z Move buttons to move the probe down to 

the desired Component Up level. Make sure this level is high enough to clear the component 

package. Press the Save button in the Component Z Up section to set the Component Z Up 

position. This will set both Z axis heads. 

The next step is to set the probe down position. 
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Use the Z Move buttons to lower the probe tip to make contact with the component pins or pads. 

You may want to lower the probes in small increments once contact is made to slightly compress 

the spring probes and ensure good contact. Do this by changing the Z Travel distance setting. The 

signature of the contact point is displayed on the Preview Tab of the Signature pane.  

Press the Save button in the Sequence Z Down section to set the Sequence Down level. This is 

the level the Prober will use when probing the component pins. 

If needed, you can also set Component Z Down and Pin Z Down levels for individual 

components and pins using. Pin Z Down settings must be set for both heads using the Z1 and Z2 

radio buttons. In general use, this is not necessary as the Down level is set at the Sequence level. 
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Manual Modes – Camera and Prober 

  

 

 

These panes in the Prober Pane are used in conjunction with the Tracker mode (Signature/Tracker 

pane) to drive the camera to a point on the board and put the Prober tip on the point. The 

signature at the point will be displayed and controlled in the Signatures/Tracker pane. 

NOTE: Camera Offset and board Alignment must be performed prior to using the Camera and 

Tracker mode together. This ensures the probe drops to the point indicated in the Camera image. 

 

 

Use the XY buttons or click in the 

camera image to move the prober to 
a point. 

Use the Z Move buttons to lower the 

probe to the point targeted by the 
camera. 
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Scanning a Sequence or Component 

 

 

Select the Sequence or Component to be scanned in the Tree Pane. 

Select the Scan tab in the Signature Pane (shown above). 

Input a Serial Number into the Serial Number field; this will be the name of the scan. 

The Stop On Failure check box will cause the scanning to stop if a component comparison fails. 

This is most useful when scanning known good boards to add as references. 

The Scan Continuous check box will cause the scan to go into a loop mode where it will scan 

without stopping until a signature comparison fails. 

Enable the Sequence checkbox if you wish to scan the selected Sequence. 

The Use Scan List check box will add the ability to use a Scan List when the Scan Sequence dialog 

appears (see Creating a Scan List section). 

Press the Start button to execute the scan. 

The test instructions prompt will be displayed. Clicking OK will start the scan for probers. Tests 

using manual probes or a Scanner will prompt the user to connect to the appropriate pin or 

component. 
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Creating a Scan List 

At this point, you have the ability to create a Scan List. A Scan List is simply a list of components 

to be scanned saved to a text file. To create a Scan List, check the Sequence checkbox and check 

the Use Scan List checkbox in the Signature pane/Scans tab. Click the Start button and click the 

Scan Lists… button in the Scan instructions dialog.  

 

 

You can also open the Scan List editor by right-click the Sequence row header and selecting Scan 

List (see image). 

 

 

A new dialog will open called Add/Edit Scan list. 
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To use the Scan List, select components on the left side of the window (you can hold the Ctrl or 

Shift keys to assist in selecting groups of components) and click the arrow buttons in the center of 

the window to add items to the list. Use the UP or DOWN arrow buttons to move a selected 

component up or down the scan list. When the desired list is assembled, click Save As… to save a 

new Scan List. Once saved, you can select the Scan List in the Scan instructions dialog by selecting 

the Browse… button and selecting the desired list. 

 

 

Click Scan Sequence to start scanning the Sequence or Component selected in the Tree pane or 

click Scan Scan List to scan the selected Scan List File. 
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Signatures will be shown in the signature window while scanning. Component name, pin and 

ranges are displayed in the status bar at the bottom of the main window.  

 

To stop a scan, press the Cancel button. 

To continue a stopped scan, press the Continue button (when enabled). 
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Click the 

Troublesheet 

BUTTON to view 

most recent scan 

results! 

Scan Results 

 

 

When a scan is complete, the results PASSED, FAILED or NO REF will be displayed (the text of the 

PASSED or FAILED message can be changed in the Tools/Options/General settings). The NO 

REF message will be displayed on the first scan of any test since there are no signatures stored as 

Reference. 

Clicking the Troublesheet button will display the signature differences in the Troublesheet tab of 

the Signature pane. 

 

Viewing Signatures – Troublesheet 

    

 

To view the Troublesheet, press the Troublesheet button in the Scan Results window. This will 

display the signatures that compare differently from the Reference signatures. 

When a scan is executed signatures are compared against the Reference set (or sets) if it exists. 

On the first scan, the signatures will be displayed in red in the No Ref tab. This occurs because the 

first scan has no reference to compare against. To add the signatures in the Troublesheet as a 

Reference, press the Set Reference button (do this only with known good signatures). Signatures 

Double click to zoom signature. Double 
click zoomed signature to un-zoom 
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of the compared signatures are displayed in contrasting colors. By default, the Reference signature 

is green and the failed signature is red. 

Use the vertical scroll bar to scroll through the scanned pins. Use the horizontal scroll bar to 

scroll the pin ranges especially if the viewing is set to Pin mode (see Viewing Signatures – Right 

Click section). 

To add the Troublesheet signatures to the Merge signature set, press the Merge button (do this 

only with known good signatures that vary slightly from the original Merge signature set). 

 

Viewing Signatures Troublesheet Report 

 

      

 

To view and print the Troublesheet report, press the Print button in the Troublesheet window. You 

can select from several options including a Sequence or Component Level report, the level of detail 

and add problem and solution comments to the report. Click Preview to view the report on-screen. 

The report can be printed or exported in several different formats including HTML and PDF by 

selecting File/Export Document in the Preview window. 
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Viewing Signatures in the Signatures Pane 

 

 

To view scanned signatures of the component selected in the Tree pane/Components tab, select 

the Signatures tab in the Signature Pane. The Scan name, date and time will be displayed on the 

left side of the window and signatures on the right. The Scale buttons will change the number of 

columns displayed. Scaling the window will increase the number of signatures displayed. The Copy 

button will copy the signatures to the Windows clipboard so they can be pasted into another 

program (in a metafile format). The Print button will print the signatures in one of several different 

user selected formats. The Troublesheet button will switch to the Troublesheet tab and display 

the Troublesheet of the scan selected in the Scan List. You can use the keyboard Shift and Ctrl 

keys to select and stack signatures in the signature boxes (shown above). The signatures will be 

displayed in contrasting colors and can be very useful if you want to make general comparisons 

among different scans. 
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Viewing Signatures – Right Click 

 

 

Additional options when viewing signatures can be displayed by right clicking in the signature area. 

Reprobe Pin Signatures: Capture signatures for all displayed ranges and prompts to replace 

signatures immediately – available in Range mode only 

Reprobe Opens – Capture signatures of all displayed open signature; Set your scale to see as 

many opens as possible. 

Real Time: Display signature in real time 

Get Signature: Capture signature of the pin/range that was right-clicked 

Get Pin Signatures: Captures signature for all ranges – works only in Range Mode 

Replace Signature: Replaces the current signature with the captured signature displayed for the 

selected pin, range and scan (shown in the Scan List to the left) 

Replace Pin Signatures: Replaces current signatures with the captured signatures displayed for 

the selected pin, all ranges and scan – works only in Range Mode 

Update Component – Re-compares and resorts the component signatures 

Sync Pin/Range: Selects pin and range in the Tree (see default in Tools/Options) 

Edit Range: Selects the pin and range in the Tree and opens the Edit Range dialog 
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Disable Range: Disables the selected range (set in the Tree pane, Ranges tab) 

Edit Pin: Selects the Pin the in the Tree and opens the Edit Pin dialog 

Edit Comp/Net: Shortcut to the selected Component Edit dialog in the Tree pane 

Teach Pin: Selects the pin the Prober Teach pane 

Teach Height Pin: Selects the pin the Prober Teach Height pane 

Group Edit: Opens Group Edit dialog for editing of component pin parameters as a group 

Net Edit: Opens Net Edit dialog for editing of Net pin parameters as a group 

SigAssist: Displays the SigAssist window showing calculated approximate values of resistance, 

capacitance, breakdown voltage, etc. based on signature information 

Sync CAD: Will link the selected signature to the CAD image displayed in the Image/CAD pane. 

Sync CAD will be disabled if there is no linked CAD data. 

Sync Image: Links current Troublesheet to the image (image created by Access Prober) in the 

Image pane/Image tab  

Copy: Places the signature image in the clipboard 

Data: Displays the signatures numeric data 

Range/Pin Mode: Displays signatures with Range priority or Pin priority - see default in 

Tools/Options) 

 

View SigAssist Information 

 

The SigAssist window can be viewed by right-clicking on a displayed signature and selecting 

SigAssist. It appears as an additional pop-up window. The information presented relates to the 

individual scans displayed in the signature. The calculated resistance, capacitance, power, forward 

breakdown voltage (Fbd), reverse breakdown voltage (Rbd), maximum voltage and maximum 

current are displayed. These values are for troubleshooting purposes only and are not intended to 

be used as true measurements. The accuracy of the SigAssist values depends greatly on the 
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scanned signature information. SigAssist values may not be calculated for signatures that do not 

contain enough information for reasonable calculations to take place (i.e. opens, shorts). The Copy 

button will put a copy of the window into the clipboard for use in other programs. 

 

Component Scans Information 

 

 

Selecting the Component Scans tab in the Tree Pane will display all of the scans performed on 

the selected component in a table format. The Scan information displayed includes the serial 

number, operator, date/time, Merge setting (checked if this scan is included in the Merge set), 

Reference setting (checked indicates it is set as a comparison Reference), Pass status (will be 

checked if components passed comparison), Removed status (will be checked if component was 

removed from Troublesheet), Area number (highest of scanned pins), Deviation, Min/Max status 

and other settings (see Help for more information). 

  

Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Row bar of the Component Scans pane displays an additional menu for 

performing specific tasks such as enabling/disabling References, deleting a scan for the selected 

components or all components and loading a Troublesheet. Enable Sequence Reference will 

mark the scan as a Reference for the entire Sequence. Disable Sequence Scan will disable the 

selected Sequence as a reference. Delete Scan will erase the selected scan for the current 
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component only. Delete Scan All Components/Nets will erase the selected scan for all 

components or nets in the Sequence. 

Load Troublesheet will display the selected scan in the Signatures/Troublesheet pane. 

 

Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Column bar of the Component Scans pane displays an additional menu for 

performing specific tasks such as sorting or globally setting parameters. The menu will vary 

depending on the column selected. In the image above, the Reference column header was right-

clicked.  

This method is the easiest way to delete non-reference scans that are listed in the Tree/Component 

Scans pane. Select a scan that is a non-reference (the Reference check box is unchecked) the 

right-click the column as shown above. Select Delete All Scans to Current 

Reference/Component/Net or Sequence to delete the non-reference scans for the individual 

Component/Net or for the entire Sequence. 

  

Component Scans – Right Clicking (Auxiliary menus)  
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Right clicking on the Column bar of the Component Scans pane displays an additional menu for 

performing specific tasks such as sorting or globally deleting items. In the image above, the Serial 

Number column header was right-clicked.  

 

Range Editing – Right Clicking (Auxiliary menus) 

It is common to edit Component Range settings directly in the Tree pane/Range tab. Be aware that 

making a change in the grid only changes the setting for the selected Pin and Range. To make 

your changes global for the Component Pins, all Components or all Sequences, right-click the 

column header and select Set Current All – (Pins, Components or Sequences). 

 

 

Sequence/Component/Pin Editing – Right Click menus  

 

 

Right clicking on the Row header bar of the Tree pane displays an additional menu for performing 

specific tasks such as Add New, Insert, Delete, Repeat, Build (repeat but with name 

incremented by 1), Copy, Paste and Cut. Right clicking works at all levels of the Tree pane 
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including Sequence, Component (shown above), Pins, Ranges and Scans. The Sync CAD option 

available at the Component and Pin levels will synchronize the selected component or pin to the 

CAD image in the Image pane. 

It is also possible to select groups of components by holding the SHIFT or CTRL keys while 

selecting components in the Tree. To copy, paste, cut or delete groups of components, use the 

Copy, Paste, Cut or Delete Toolbar buttons below the main menu.  

 

Component Editing – Component Group Edit 

 

 

Right clicking on the Row header bar of the Tree/Components pane allows for editing of the 

Component information. Select Group Edit to open the Group Edit window for the selected 

Component. This allows you to duplicate changes made to the selected Component to other 

Components in the Tree.  

Note: Be sure to make your changes to the selected Component before using Group Edit to 

duplicate the settings to other Components. 
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To use the Component Group Edit, select the Components on the left that you wish to change. You 

can use the SHIFT and CTRL keys to select groups or individual Components in the list. Mark the 

setting you want to change by clicking the checkbox. The example above shows the Component Z 

UP as the setting to change. Click Process to make the changes to the selected Components.  

 

Using Component Group Edit to Offset XY Pin Locations 

The Component Group Edit can be used to move the XY pin locations for a component a set 

distance away from the component body. This can be very useful if imported CAD data places the 

probing location too close to the component body resulting in bad or no probe contact.  

Open Component Group Edit by right-clicking the Row header for any component in the Tree 

pane/Component tab. When the Component Group Edit window is displayed select the All Pins tab 

on the right side. 

 

Select the components on the left that you wish to offset pin XY locations making sure that they 

are the same style. You can use the SHIFT and CTRL keys to select groups or individual 

Components in the list. Input an offset distance in the Distance field using the unit set for the 

Sequence (mils, mm, microns; the above example is using microns). Select the component Style 
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as 1 Pin (DH/DH2), 2 Pin, SMD DIP (dual inline package) or Square QFP (quad flat pack). At 

this time 3 pin components and rectangular IC packages are not supported. Click Process to make 

the changes. 

 

Pin Editing – Pin Group Edit and Net Edit  

 

 

Right clicking on the Row header bar of the Tree/Pins pane allows for editing of the pin information. 

Select Edit to open the Edit window for the selected pin. 

Note: Some Pin settings can also be edited directly in the Pins grid by clicking the appropriate field 

and modifying the setting.  

Group Edit and Net Edit allow you make changes to the pin of a component and have those 

modifications also change components that have the same number of pins within the same 

Sequence.   

 

 

 

 

Change the desired settings for the 

current Pin first then select Group 

Edit from the right-click menu (see 

above). Components with the same 

number of pins will be listed. Select 

the components and pins you want to 

be changed. Select the Pin Settings 

check box(s) for the setting(s) you 

want changed. Check the Ranges box 

to match the ranges (this will cause 

signatures to be deleted). Click the 

Update Pins/Ranges button to 

make the changes. 
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Pin Editing  

 

 

Individual pin characteristics can be edited in the Pin Edit window. Pin Name, Net name, 

Channel, Correction steps (for Access Probers), Scan Pin (enable/disable scanning of the pin) 

and Pause (pause scan at this pin) can be controlled. 

Use the Workstation Help to learn more about other features in this window. 

 

Realign Function 

There may be situations where you wish to move or rotate your PCB mounted in an Access Prober. 

Realign provides this function as well as the ability to simply choose new Alignment points if you 

are not happy with the current ones. 

The process for using Realign is very straightforward and essentially the same for single and dual 

head Access Probers. 

- Go to the File menu and select Save Copy to save a backup of your test (just in case). 

- Place the PCB into the Access Prober in the desired position. This means that if you are rotating 

the PCB mount it in the rotated position. 

- Important!! Perform an Alignment (Align tab) as accurately as possible using the original 

alignment points. Keep in mind that if you moved or rotated the PCB you will need to locate the 

original alignment points at their new position. It is important to be precise during this step as any 

error introduced at this step will be reflected to all of the component/net positions. 

- Switch to the Teach tab and verify the position for a few components. Try to review the positions 

of several component pins in different parts of the PCB in both the X and Y directions. If the 

positions look good proceed to the next step. 
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- Select the Realign tab and perform the alignment again using the desired alignment points. They 

can be the same as the original points or you can select new ones. Click the Set button after 

positioning each alignment point. 

 

   

 

- Click the Save button to save the new alignment points. Built into the Realign function is the 

capture of new images used by the Auto Align function. 

- You will need to create a new board Image in the Image pane/Image tab after a Realign is 

performed (see the Creating a Board Image section earlier in this tutorial). 

 

ViewPCB Image 

 

 

For Prober users, when XY locations to test are stored, the Image/ViewPCB pane is automatically 

updated. To view the Image/ViewPCB image, select the Image/ViewPCB pane. Right-click on the 

image to display a menu where you can select Save As to save the image or use the Copy to save 

it to the clipboard for use in other programs. Refresh will update the ViewPCB window. 
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Test Creation - Panelize 

 

 

In some cases, a PCB may be part of a panel of similar boards.  

Note: Panelize is designed to work with alignments points selected on the actual PCB not a panel 

frame. 

To easily create subsequent panels based on the original panel, select Panelize in the Prober Pane 

(shown above). 

Select a point on the first panelized PCB and press Set in the Current Origin section. The XY 

coordinates of the source origin will be displayed. 

Move the camera to the same point on the next panel and press Set in the Add Origin area. The XY 

coordinates of the second origin will be displayed. Set a rotation value in the Rotation field. 

Press the Panelize button and a new Sequence will be created in the Tree/Sequence pane. The 

name will be incremented by 1 or by one letter. The new panel will be an exact duplicate of the 

original but have its location offset as configured during the Panelize process. 
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Test Creation – Convert step 1 

 

 

If you are moving to Huntron Workstation version 4 from Huntron Workstation version 3 then you 

will want to utilize the tests created in the older version. Version 4 uses a different database 

structure so the old tests need to be converted for use in version 4. 

To start, select Convert from the File menu. The Select System to Convert window will open. The 

default directory name for version 3.X is “winhunt”. Browse to the winhunt directory. Select the 

SYSTEM.DBF file and click Open. 
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Test Creation – Convert step 2 

 

 

Once SYSTEM.DBF has been opened, a list of the Systems and Boards contained in the DBF will be 

displayed. 

Select the System and Board to convert as shown above. 

Press the Next button to continue to the next step. 
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Test Creation – Convert step 3 

 

 

Input the File Name of the new Board File.  

Click Save to create and save the new Board that is compatible with Huntron Workstation version 

4. 

A pop-up window will ask if a Huntron Access prober was used to create the original test. Click Yes 

or No accordingly. 

 

 

 

Note: It is very important for Prober users to verify the Teach Height settings after Converting a 

board test. 
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Test Creation – Convert Status 

 

 

 

The Convert status (shown above) will be displayed as the Board is converted. You will be 

prompted when the conversion is finished. The new board will automatically be opened in Huntron 

Workstation when the conversion is complete.  
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Huntron Workstation Buttons Feature 

Huntron Workstation has a built-in feature that allows any Windows based program to be started 

by clicking a button in the Workstation toolbar. It is very easy to use and a “Button” can be 

attached to any Board, Sequence or Component/Net. In this example, a Button will be created for a 

Sequence but the process is the same for the Board and Component/Net levels. 

To start, the Sequence edit window is opened by right-clicking the row header for the desired 

sequence. The Edit window will be displayed (see below). 

 

 

Select the Buttons… button located on the right side of the Sequence Edit window to open the 

Buttons Setup window. 
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To configure the Button, a Caption (button name displayed in the Tools menu), Command Line (the 

application to be run) and File Path (the file opened by the executed application) need to be input 

into the corresponding fields. A File path will not always be required such as instances where a 

browser is started and pointed to a specific URL. In this example, the button will be configured to 

start the Microsoft Paint application and open a small PCB image (see image below). If desired, the 

icon displayed in the main window toolbar can be set by browsing to and setting a path to an .ICO 

(icon) file in the Icon File Path field. Add text that will be displayed when the cursor is placed 

over the Button in Tooltip field. To make the linked file or icon stored as part of the Board 

database, check the Store File and/or Store Icon checkboxes. 

 

 

 

Click OK to accept the Button. To create additional Buttons, repeat this process and click the Add 

New button in the Button Setup window. 

When Buttons are created, an additional toolbar will appear below the Huntron Workstation menu. 

This toolbar will change according to the level (Board, Sequence or Component/Net) selected. 

  

 

 

The icon shown can be replaced by selecting an appropriate icon in the Button Setup window (the 

default icon is shown). Click the toolbar button to execute the Button.  
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Technical Support 

For questions or assistance in using Huntron Workstation, contact Huntron at  

800-426-9265, 425-743-3171 or email at info@huntron.com.  

 

There is online assistance for Huntron Workstation on the Huntron website: 

Software updates: www.huntron.com/sales-support/software.htm 

Tutorials: www.huntron.com/sales-support/training.htm 

Technical Support, support documents and “Quick Tips”: www.huntron.com/sales-

support/techsupport.htm 

 

 

 

  

http://www.huntron.com/sales-support/software.htm
http://www.huntron.com/sales-support/training.htm
http://www.huntron.com/sales-support/techsupport.htm
http://www.huntron.com/sales-support/techsupport.htm
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Appendix 1: Using the Set Size Feature for Access Probers 

 

The Set Size feature allows the user to make adjustments to the dimensions (units of measure per 

pixel) of the image used in the Offset, Align, Teach and Realign windows. This is useful to adjust 

accuracy when clicking in the image to move to a point and to create better stitching of the image 

used in the Image pane/Image tab. 

The Set Size feature is available by clicking the Set Size button in the Prober pane/Offset tab. The 

dimensions shown in the Set Size window when opening it for the first time will be factory default 

values. 

The basic rules for making adjustments in the Set Size window are: 

- When clicking on a point in the camera image and the camera moves too far – decrease 

the Horizontal Length and Vertical Height values 

- When clicking on a point in the camera image and the camera moves too short – increase 

the Horizontal Length and Vertical Height values 

 

Use the following example to help learn the process of calculating and adjusting the values. In this 

example we will be adjusting for a camera that moves too short. Before starting, make sure the 

circuit board is mounted at the Slot level set for the selected Sequence. The board cannot 

be above or below the selected Slot level. 

Place the camera crosshairs on a point on the circuit board. Next, click on a point at the extreme 

left or right edge of the image, in this case, the left side was used. 

 

 

Clicked location 
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Notice that the camera crosshairs did not go to the clicked location but fell short. 

 

 

To measure the distance from the crosshairs to the clicked location, move the mouse cursor 

(crosshairs) to the clicked location but do not click. The distance between the camera crosshairs 

location and the clicked location will be shown on the Mouse X field of the Offset window (red 

box). Write this value down. 

 

 

Clicked location 

Clicked location 
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The next step is to calculate the vertical distance. Put the camera crosshairs on a point on the 

circuit board. Click a location on the extreme top or bottom edge of the camera image. In this 

example, the top edge was used. 

 

 

 

Notice that the camera crosshairs did not go to the clicked location but fell short. 

 

 

As you did with the horizontal distance, you will need to measure the distance from the camera 

crosshairs to the clicked location by moving the mouse crosshairs to the clicked location. 

Clicked location 

Clicked location 
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Move the mouse cursor (crosshairs) to the clicked location but do not click. The distance between 

the camera crosshairs location and the clicked location will be shown on the Mouse Y field of the 

Offset window (red box). Write this value down. 

 

Click the Set Size button and you will see this window displayed. The values shown will be the 

factory default unless they were changed previously. 

 

 

Using the X measurement you wrote down earlier, multiply this distance X2 and add the result 

to the Horizontal Length value. Next, multiply the Y measurement written down earlier X2 and 

add the result to the Vertical Height value. It is necessary to multiply by 2 because the dimension 

needs to be corrected in two directions, top edge to bottom edge and left edge and right edge. The 

image below shows that values with the measured corrections made. 

 

Clicked location 
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Click OK to save the changes and try clicking in the camera image. You will find that the accuracy 

is much better. You may need to make additional small adjustments to achieve satisfactory 

accuracy. If you have a board image already created in the  

Image pane/Image tab, you will want to recreate the image again. The result should be better 

stitching at the image tile seams and an overall better image. 
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Appendix 2: Huntron Workstation Archive Scans Feature 

The Archive feature built into Huntron Workstation allows you store and remove Sequence scans 

from the working database to achieve better performance. These archived scans are not deleted 

but saved away in a different database table and can be restored at any time. It is very simple to 

use. 

 

 

- Select "Archive Board Non-Reference Scans" from the Workstation Edit menu 

- At this point the software will search the database for non-reference scans that were part of a 

Sequence scan and remove them from the active database 

- If you look at the Components Scans tab in the Tree pane, you will see that the Reference scans 

remain 

- To unarchive a scan, select "UnArchive / Delete Board Non-Reference Scans" 

- The Sequence Scan Archive window will be displayed 
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- You will see the Archive Scans listed where you can select the scan you want to restore to your 

test Sequence. Use the CRTL or Shift keys to select multiple scans if needed 

- Click the UnArchive button and the selected scans will be restored to the Sequence 

- Use the Delete button to permanently delete scans that are no longer needed. 

- Close the Sequence Scan Archive window and look at your Component Scans tab and you will see 

that your scans have been restored. 

Keeping your test database small is the best way to get the most out Huntron Workstation 

performance. 
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Appendix 3: Adjusting Camera Settings and Ring Lights on Access DH and 

DH2 

The Access Dual Head probers have the ability to custom configure the camera settings (DH and 

DH2) and ring light brightness (Access DH2 only). These settings can be configured for the lighting 

in your environment and saved. We have found that relying on the Auto features for the Access 

DH/DH2 cameras to be less than optimal in many cases therefore we recommend setting up the 

camera adjustments for your system manually and saving them. 

 

Close the Prober door to minimize any affect from outside light. Start by going to the Prober pane/ 

Camera tab and selecting Z1. Move the Z1 camera to location over a circuit board mounted in the 

probing area. 

 

 

 

Once the board is in view, click the AF button (Access DH2 only; Access DH users should manually 

adjust the focus if needed) to have the camera autofocus on the board surface. If the focus is still 

blurry, click the AF button again to readjust. 

Adjust the ring light Brightness to 10 (Access DH2 only). This is a good starting point by adding 

some light to the area but is not overpowering causing excessive glare. 

  

Ring light 

Brightness 

Adjustment 

AF button 

Properties 

button 
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Click the Properties button to display the camera Device Properties window. It is important that 

you arrange the windows as shown below so you can see the Device Properties window at all times. 

 

The settings shown below are a good starting point for your adjustments. Select the Exposure tab 

and uncheck ALL of the Auto checkboxes. If needed, adjust the Brightness and Exposure 

settings to get the best image.  

 

 

 

Click the Update and Apply buttons after each adjustment to the settings and then click in the 

Prober Camera image to update the image. Adjust your settings as needed to try to reduce any 



© Huntron, Inc 2020 Rev. 10 81 

glare and achieve the best image contrast possible. Click the OK button when you have the best 

image. 

 

Click the Save button to save the current settings. 

Select the Z2 camera and perform the adjustments similar to the Z1 camera. Try to match the 

image appearance of the z1 camera as close as possible. 

 

 

 

When finished adjusting the Z2 camera settings, click the Save button to save the current 

settings. 
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Appendix 4: Manually Placing Component Tags in the Image Pane/Image 

tab 

Tracker users will appreciate this feature which allows you to manually place tags with the 

Component name in the board overview image in the Image pane. 

You will first need to get a high quality image of your PCB then select the Sequence where you 

want to use the image. Select Edit Sequence (Ctrl+E) from the Edit menu. Select the Top 

Image tab or Bottom Image tab depending on the Side setting used above (red arrow). Click the 

Load… button and browse to select and Open your image. 

 

 

 

The image should now be displayed in the Top (or Bottom) Image tab. Click OK to close the Edit 

Sequence window. 

The image you loaded should now be showing the Image pane/Image tab. If you do not see the 

Image pane go to the Window menu and select Image Pane. You may need to adjust your 

Workstation layout by click-dragging the panes by the title bar to get the arrangement that suits 

your needs. 
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To place a Component name tag in the image, select the Component in the Tree pane/Component 

tab then right-click at the component’s location in the image. It is best to click slightly left of 

center as the text will be left justified. Select Set Component Position from the right-click popup 

menu to place the tag. You should see a grey name tag appear. 

 

 

 

It is recommended you add all of the tags before running any scans.  

The radio buttons on the left side (red box) control what is displayed in the image. None disables 

the tags, Current displays the tag of Components in the current Troublesheet (green tags for 

Passed and red tags for Failed) and Comps displays all tags in grey.  
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You can have the tags appear during scanning by selecting the Tools menu/Options/Scan tab 

and enabling Show Components on Image. As you run your test, a green (Passed) or red 

(Failed) tag will appear on the component in the image to indicate its test status. This works the 

same with Prober systems as well. 

 

 


